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Abstract 

Title: Phonon Polariton Enhanced Infrared Waveguides 

Author: Yuchen Yang 

Major Advisor: Brian A. Lail, Ph.D. 

 

 

The need for robust, reliable and sensitive terahertz (THz) sources and detectors has 

motivated the research into waveguiding structures. The increasing adoption of 

micro- and nanofabricated optical components addresses the critical challenge of 

guiding light with subwavelength confinement. Surface plasmon polariton (SPP) 

waveguides are among the most promising candidates for manipulating light on 

subwavelength scales and harbor many potential applications at visible and near-

infrared (NIR) wavelengths. However, the metal in the waveguide yields very weak 

or nonexistent response in the mid and long wave infrared range, since metal in this 

region is very lossy and has large magnitude real and imaginary permittivities. This 

is one of the major reasons for the rise in popularity of surface phonon polariton 

(SPhP) waveguides in recent research and micro- and nano-fabrication pursuits.  

Silicon carbide (SiC) is a good candidate in SPhP waveguides since it has negative 

dielectric permittivity in the long-wave infrared (LWIR) spectral region, indicative 

that coupling to surface phonon polaritons is realizable. Introducing surface phonon 

polaritons for waveguiding provides good modal confinement and enhanced 
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propagation length. A hybrid waveguide structure at LWIR based on an eigenmode 

solver approach in Ansys HFSS is presented. The effect of a three layer configuration 

i.e., silicon wire on a benzocyclobutene (BCB) dielectric slab on SiC, and the effects 

of varying their dimensions on the modal field distribution and on the propagation 

length, is studied. 

In recent years, extensive research has been conducted on hexagonal boron nitride 

(h-BN), which has shown h-BN to have naturally occurring subwavelength-

volumetrically-confined hyperbolic phonon polaritons (HPhPs) and surface phonon 

polaritons (SPhPs). First, we have designed a hybrid phononic waveguide containing 

a hyperbolic h-BN slab lying on a lossless dielectric substrate coupled with a cylinder 

dielectric waveguide in the air gap and the SPhP mode results in an extremely 

confined hybrid phononic mode. The coupling between photonic cylinder and 

phononic surface enhances the confined modal area up to 10-3 λo
2 (λo is the free-space 

wavelength) and enables propagation distances up to more than two orders of 

magnitude above the operational wavelength. In order to improve the waveguide 

properties, the long range phonon polariton has been adopted in a new design. This 

work presents numerical results for both long- and short-range phononic volumetric 

polariton modes in a slab of h-BN. A hybrid long-range phononic waveguide results 

when two identical dielectric cylinder wires symmetrically placed on each side of the 

h-BN slab are coupled to the long-range HPhP mode. Based on analytical coupled-

mode theory and computational finite element analysis, we have investigated the 
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modal characteristics of the hybrid long-range phonon polaritonic waveguide. The 

strong coupling between the high index cylindrical waveguide mode and the HPhPs 

in a h-BN thin film, subwavelength modal area can be achieved which is 

approximately 10−2λo
2 while enabling propagation distances up to 370λo.      
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Chapter 1  

Introduction 

1.1 Background 

The accepted spectral limits of the mid-infrared (mid-IR) wavelength range vary 

between subjects and applications. In this work, we will consider the mid-IR 

wavelength range from 3μm to 50μm. Terahertz (THz) technology research is closely 

connected with humans. For instance, the changing of global atmospheric detection, 

especially the density of CO2 in atmosphere, directly affects our understanding of 

global warming. Therefore, it is significant to precisely detect the content of the gas 

surrounding earth and the variation of the gas density. These detections correspond 

to the sensitivity of infrared sensors and infrared imaging technology. Also, 

biochemical sensing and biochemical detection are now drawing increasing 

attention. In view of the capability to probe the effects of medicine in the human 

body and to diagnose disease, it is essential to improve the sensitivity and accuracy 

of the biochemical sensor and detector. In order to respond to these critical 

applications, research in the teraherz and in mid-infrared (mid-IR) should be 

promoted. However, the mid-IR region presents significant technological limitations 

to the photonic system which is associated with the lack of THz laser sources, 

efficient low loss waveguide systems and high-sensitive imaging techniques. 
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Recently, the advancement of waveguides in mid-infrared have received attention. 

Surface plasmon polariton (SPP) waveguides have been studied in many designs in 

the optical spectrum but with limited performance in the mid-IR region. In this 

research, the surface phonon polariton (SPhP) will be applied since the IR materials 

supporting SPhP coupling in dielectric could eliminate the metallic losses in SPP 

waveguides. 

Surface phonon polaritons can be excited in polar dielectric crystals and support 

sub-diffraction-limited modes. The potential technological advantages of these polar 

materials are applied in propagating surface modes in waveguides and novel 

metamaterial designs which can achieve low-loss, mode-confined waveguides and 

metamaterials in the mid-infrared spectral region. The structure of the waveguide 

and the material analysis is the core feature to characterize the design, with the goal 

of realizing potential applications. 

1.2 Motivation 

The temporal resolution of detector and the study of spectroscopy motivates research 

into infrared (IR) and optical structures capable of guiding light with sub wavelength 

confinement [1, 2]. There are numerous studies of surface plasmon polariton 

waveguides [1, 3, 4, 5], and they have stable property applications such as plasmonic 

nanolithography [6], near-field scanning optical spectroscopy (SNOM) [7], data 

storage [8], and biosensing [9]. The SPPs are transverse surface charge waves 
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accompanying electromagnetic fields localized at an interface between a metal and a 

dielectric at the visible and near-IR region [10, 11]. However outside the optical 

region the benefit of SPPs start to disappear. First, metal in IR/THz inherently 

provide a large permittivity that leads to poor confinement of SPP fields. On the other 

hand, the losses of the metal always exists, which causes the plasmonic response of 

the metal to be either far too weak or nonexistent at lower frequencies (mid-IR 

range).  Several studies have considered traditional microstrip and two-wire 

transmission line structures, however, metal losses lead to unacceptably short 

propagation lengths [12, 13]. 

A new approach is to eliminate the disadvantages of SPPs by using surface 

phonon polaritons (SPhPs) -a collective excitation comprised of an electromagnetic 

(EM) wave coupled with polar lattice vibration [14], whose electromagnetic field 

decays exponentially away from the interface and thus provides strong confinement 

[15, 16]. Integrated polaritonics has the potential to revolutionize next-generation 

devices operating in the THz portion of the electromagnetic spectrum in much the 

same way that integrated electronics and integrated photonics have revolutionized 

the microwave and near-infrared regimes, respectively. 

The propagation distance of waveguide modes performing in mid-infrared region 

is limited by the structure and material selection. Nowadays, hexagonal boron nitride 

(h-BN) manifest low-loss, mid-infrared, natural hyperbolic material and h-BN slab 

thinned down to approximate 1 nm which may achieve multi-layer waveguide 
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maintaining long propagation distance similar to nanophotonics in mid-infrared 

region. Silicon carbide has negative real part permittivity in the reststrahlen band and 

h-BN has two spectral bands with these characteristics which are the lower 

reststrahlen band and the upper reststrahlen band. Van der Waals heterostructures 

manifest unusual properties and new phenomena which are considered as 2D crystals 

are constructed layer by layer; h-BN is one of the materials which can be achieved 

in the atomic scale. In order to achieve better performance in an infrared waveguide, 

the waveguide could be constructed on van der Waals heterostructures and combined 

with phonon waveguide. There is a wide range of study in guiding light in the 

nanoscale, for example one dielectric wire embedded above in close proximity to a 

surface and interacting with phonon polariton modes, and there are other potential 

structures expected to achieve the subwavelength confinement and relatively large 

propagation distances. By maintaining a gap between two dielectric wires which may 

give a major part of the electromagnetic field confined in the gap due to external 

reflections provided by interference effects.  

Photonic circuits in the mid-infrared spectral range are relatively unexplored 

compared with studies in the visible and near-IR regions. Photon energies in the mid-

IR spectrum match well with molecular vibrations which enable chemical and gas 

sensing. Waveguiding structures producing hybrid modes that result from the 

coupling between phonon polariton modes and photonic modes for mid-IR 

applications hold great potential and need to be studied.  
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1.3 Layout of the Dissertation Document 

This document is a comprehensive report on the research performed at the 

Applied and Computational Electromagnetics Lab at Florida Institute of Technology 

(FIT). Chapter 2 presents a theoretical framework that allows us to study the 

electromagnetic (EM) phenomena related to the hybrid phononic waveguides. We 

study a numerical formalism that is obtained from the macroscopic Maxwell 

equations and the finite element numerical approach. We characterize the phonon 

polariton properties and demonstrate how to obtain an analytical formula for the 

surface waves. The properties of surface phonon polaritons and long-range phonon 

polaritons are analyzed. In Chapter 3, a SiC based hybrid waveguide is proposed, 

modeled, simulated, and discussed. This part of the work is presented at the SPIE 

2015 conference (Yuchen Yang, Franklin M. Manene, Brian A. Lail, "Infrared 

surface phonon polariton waveguides on SiC Substrate", Proceedings of SPIE Vol. 

9547, 954723 (2015)) [17]. In Chapter 4, a naturally-occurring hyperbolic response 

material h-BN is used in a novel hybrid waveguide design. This part of work is 

presented at Optic Express (Yuancheng Xu, Navaneeth Premkumar, Yuchen Yang, 

and Brian A. Lail, "Hybrid surface phononic waveguide using hyperbolic boron 

nitride," Opt. Express 24, 17183-17192 (2016)) [18]. In Chapter 5, a hybrid long-

range hyperbolic phonon polariton (HPhP) waveguide consisting of two identical 

dielectric cylindrical wires placed symmetrically about a h-BN slab embedded in a 

low-permittivity dielectric medium in the Type II reststrahlen band is designed. 
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Previously, we designed a hybrid phonon-polariton waveguide using a single 

dielectric cylinder coupled to h-BN Type II polaritons on low index substrate. 

Compared with our previous work, our new design is capable of achieving three 

orders of magnitude larger propagation length while maintaining the same degree of 

mode confinement. Recent research [19] studied insulator-hyperbolic boron nitride-

insulator (IHI) structures in the Type II reststrahlen band. The IHI structure was 

shown to support long-range propagating polariton modes with propagation lengths 

higher than a Ag/MgF2 hyperbolic metamaterial waveguide. In our design, we 

clearly define the properties of hybrid short-range and long-range HPhPs. The results 

in here also show that the hybrid long-range HPhP structure has much higher modal 

confinement than IHI structures seen before. This work is presented at Optic Express 

(Yuchen Yang, Michael F. Finch, Di Xiong, and Brian A. Lail, “Hybrid long-range 

hyperbolic phonon polariton waveguide using hexagonal boron nitride for mid-

infrared subwavelength confinement,” Opt. Express 26, 26272-26282 (2018)) [20]. 

Chapter 6 draws conclusions and suggestions for future research. 
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Chapter 2  

Surface phonon polaritons fundamentals and 

methods 

2.1 Introduction 

A phonon is a quantum of crystal vibrational energy [21]. It can be regarded as an 

elementary excitation activated by the relative motion of atoms in a crystal [21]. It 

can be characterized as a quasiparticle of zero spin which at a given temperature of 

the crystal is governed by the Bose-Einstein distribution function [21]. In order to 

understand various properties of three-dimensional solids, surfaces, and 

nanostructured materials, phonon dispersion relations are the fundamental key. A 

polariton is generated if electromagnetic radiation in crystalline solids interacts with 

resonant material excitations, including phonon polaritons, plasmon polaritons and 

exciton polaitons among others. A surface polariton is simply an electromagnetic 

wave that propagates along the interface between two media [16]. Surface plasmon 

polaritons, SPPs, which have been widely studied, are electromagnetic waves 

interacting with free electrons of the conductor and excite surface waves decaying 

away from the surface. By tuning the structure of the metal surface sub-diffraction 

confinement of the optical fields can be achieved [22]. Plasmonic studies achieved 

abundant applications such as improved chemical detection [23] and enhanced 
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quantum efficiency for detectors in the ultraviolet (UV), visible [24] and near-

infrared (NIR) spectral ranges [25, 26, 27, 28, 29, 30]. However, the high optical 

losses inherent in metals limited the applications. Furthermore, the potential 

applications which based on plasmonics has been demonstrated in the UV to NIR 

spectral region, there exists lack of usage beyond NIR since materials provide large 

negative permittivity causes poor SPP field confinement in the mid-infrared 

spectrum [31, 32, 33]. In recent years, there are studies using transparent conductive 

oxides and graphene, in order to identify potential lower loss plasmonic materials 

[34, 35, 36]. Nevertheless, these materials still require free electrons or holes to 

sustain the localized electromagnetic fields and thus to have a tendency to be lossy 

due to the associated fast plasmon decay. By using dielectric materials one can 

promptly decrease optical losses, but resonators with sub-diffraction-limited optical 

confinement cannot be achieved using positive permittivity materials [37, 38, 39, 

40]. 

The sub-diffraction confinement of light, low optical losses and operation in the 

long wavelength infrared region (LWIR) can be simultaneously achieved by using 

polar dielectric materials which is the result of polar optical phonons, or polar lattice 

vibrations, interacting with long wavelength incident fields from the mid-IR, creating 

a surface excitation mediated by the atomic vibrations named surface phonon 

polaritons (SPhPs). The SPhPs at the interface between a dielectric and polar crystal 

have combined electromagnetic wave and surface wave characteristics as shown in 
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Fig. 2.1.  

 

Fig. 2.1. Surface wave excitation at the interface between dielectric and 

polar dielectric. The field in y direction is said to be evanescent, preventing 

power from propagating away from the surface.  

 

The polar dielectric material has been observed with high reflectivity and negative 

Re(ε) within the “reststrahlen” band that provide SPhP phenomenon. The reststrahlen 

band is bound by the transverse optical (TO) and the longitudinal optical (LO) 

phonon frequencies. The two phonon modes correspond to out-of-phase atomic 

lattice vibrations with k-vector aligned parallel (LO) and perpendicular (TO) to the 

incident field, with the positive (negative) charged lattice sites moving with (against) 

the direction of the field [41]. 

2.2 SPhP existence requirement 

Surface phonon polariton excitations can provide low loss, sub-diffraction-limited 

optical modes which consist in the long lifetimes of phonon modes in polar 
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dielectrics. There exist a momentum mismatch between the incident electromagnetic 

wave and the SPhPs. This mismatch can be solved considering the coupling of the 

incident field to surface modes through a diffraction grating [42], high index prism 

[43, 44, 45], scattering from a nearby sub-wavelength particle such as an SNOM tip 

[46, 36, 47, 48] or via nanostructure of the SPhP material into sub-wavelength 

particles [49, 50, 51, 41]. The propagating modes will be discussed. In order to 

comprehend the effect of the SPhP in a hybrid waveguide, the analysis should start 

from the classical Maxwell’s equations. The polar dielectric and low index dielectric 

interface excited by mid-infrared wave structure has dielectric permittivity ε1 and 

polar dielectric 𝜀2 is shown in Fig. 2.2. 

 

        Fig. 2.2. Interface between dielectric and polar dielectric material. 

 

The Maxwell’s equations of macroscopic electromagnetism forms are: 
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        𝛻 × �⃗⃗� = 𝐽 𝑒𝑥𝑡 +
𝜕�⃗⃗� 

𝜕𝑡
 

(2.1) 

𝛻 × �⃗� = −
𝜕�⃗� 

𝜕𝑡
 

(2.2) 

     𝛻 ∙ (�⃗⃗� ) = 𝜌𝑒𝑣_𝑒𝑥𝑡     (2.3) 

𝛻 ∙ (�⃗� ) = 𝜌𝑚𝑣      (2.4) 

�⃗⃗�  is the electric flux density (coulombs/square meter), �⃗�  is the electric field intensity 

(volts/meter), �⃗�  is the magnetic flux density (webers/square meter), �⃗⃗�  is the 

magnetic field intensity (amperes/meter), 𝜌𝑒𝑣_𝑒𝑥𝑡  is the external charge density 

(coulombs/cubic meter), 𝜌𝑚𝑣 is the magnetic charge density (webers/cubic meter) 

and 𝐽 𝑒𝑥𝑡 is the external current densities (amperes/square meter). The constitutive 

relations are: 

     �⃗⃗� = 𝜀̂ ∗ �⃗�      (2.5) 

     �⃗� = �̂� ∗ �⃗⃗�      (2.6) 

where 𝜀̂ is the time-varying permittivity of the medium (farads/meter) and �̂� is the 

time-varying permeability of the medium (henries/meter). For free space 𝜀̂ = 𝜀0 =

8.854 × 10−12 (farads meter⁄ ) and �̂� = 𝜇0 = 4𝜋 × 10−7(henries meter⁄ ). 

2.2.1 The wave equation  

In order to investigate the physical properties of surface phonon polaritons, we have 

to apply Maxwell’s equations (2.1) - (2.4) to the flat interface between a polar 
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dielectric (permittivity is negative) and a low index dielectric. Maxwell’s equations 

are coupled partial differential equations, therefore each equation has more than one 

unknown field. In order to uncouple these equations and combine with boundary 

condition to obtain the electromagnetic field solutions the wave equations, which are 

the uncoupled second-order partial differential equations, are necessary. In the 

following, we will limit ourselves to linear, isotropic and nonmagnetic media and the 

permittivity is ε = 𝜀𝑟𝜀0, where 𝜀𝑟 is the relative permittivity. 

Equation (2.1) and (2.2) are first order and coupled differential equations. Taking 

the curl of both sides of Eq. (2.1) gives Eq. (2.7). 

     ∇ × ∇ × �⃗⃗� = ∇ × 𝐽 𝑒𝑥𝑡 + ∇ ×
𝜕�⃗⃗� 

𝜕𝑡
 

       

                                                               = ∇ × 𝐽 𝑒𝑥𝑡 + ε
𝜕

𝜕𝑡
(∇ × �⃗� ) 

 

    (2.7) 

Substituting (2.2) into the right side of (2.7) and using the vector identity 

    ∇ × ∇ × 𝐴 = ∇(∇ ∙ 𝐴 ) − ∇2𝐴     (2.8) 

in the left side, we can rewrite (2.7) as  

               ∇(∇ ∙ �⃗⃗� ) − ∇2�⃗⃗� = ∇ × 𝐽 𝑒𝑥𝑡 − ε𝜇0

𝜕2�⃗⃗� 

𝜕𝑡2
 

 ( (2.9) 

Substituting  
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                                            ∇ ∙  �⃗� = 𝜇0∇ ∙ �⃗⃗� = 𝜌𝑚𝑣 → ∇ ∙ �⃗⃗� = (
𝜌𝑚𝑣

𝜇0
) (2.10) 

into (2.9), we have that  

              ∇2�⃗⃗� = −∇ × 𝐽 𝑒𝑥𝑡 + 𝜀𝜇0

𝜕2�⃗⃗� 

𝜕𝑡2
+

1

𝜇0
∇(𝜌𝑚𝑣) 

 (2.11) 

 

A similar process, starting by taking the curl of Eq. (2.2), produces Eq.(2.12). 

              ∇2�⃗� = 𝜀𝜇0

𝜕2�⃗� 

𝜕𝑡2
+

1

𝜀
∇(𝜌𝑒𝑣_𝑒𝑥𝑡) 

  (2.12) 

 

Therefore, Eq. (2.11) and (2.12) are uncoupled second-order differential equation for 

�⃗⃗�  and �⃗�  and are referred to as the vector wave equations for �⃗⃗�  and �⃗� . For source-

free regions (𝜌𝑚𝑣 = 0 , and 𝜌𝑒𝑣_𝑒𝑥𝑡 = 0 ) and lossless media (σ = 0) , the wave 

equations (2.11) and (2.12) simplify to  

              ∇2�⃗⃗� = 𝜀𝜇0

𝜕2�⃗⃗� 

𝜕𝑡2
 

 (2.13) 

 

              ∇2�⃗� = 𝜀𝜇0

𝜕2�⃗� 

𝜕𝑡2
 

     (2.14) 

 

2.2.2 Surface phonon polaritons at a single interface 

From the geometry in Fig.2.2, the wave propagating in z direction and it is uniform 

in the x axis, therefore neither the field nor the structure is changing in x direction. 

Therefore, the derivative in the x direction is equal to zero (𝜕 𝜕𝑥⁄ = 0). For harmonic 

time dependence �⃗� (𝑟 , 𝑡) = �⃗� (𝑟)𝑒𝑗𝜔𝑡 (𝜕 𝜕𝑡⁄ ↔ 𝑗𝜔) of the electric field. Inserted into 

Eq. (2.14), this yields 
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              ∇2�⃗� + 𝑘0
2𝜀𝑟�⃗� = 0   (2.15) 

 

where 𝑘0 =
𝜔

𝑐
 is the wave number of the propagating wave in vacuum and c =

1

√𝜀0𝜇0
 

is the speed of light. According to the electromagnetic surface problem, the plane y 

= 0 coincides with the interface sustaining the propagating waves, which can be 

described as �⃗� (𝑥, 𝑦, 𝑧) = �⃗� (𝑦)𝑒𝑗𝛽𝑧 . The complex parameter β = 𝑘𝑧  is the 

propagation constant of the traveling waves and the complex exponential, 𝑒𝑗𝛽𝑧 , 

indicates that the wave is propagating in the z direction. Take this expression into Eq. 

(2.15), the wave equation becomes, 

              
𝜕2�⃗� (𝑦)

𝜕𝑦2
+ (𝑘0

2𝜀𝑟 − 𝛽)�⃗� = 0 
(2.16) 

 

Equation (2.16) is the beginning of the general analysis of guided electromagnetic 

modes in waveguides. In order to use the wave equation for determining the field 

profile and dispersion of propagating waves, we need to find the expressions for the 

different field components of �⃗�  and �⃗⃗� . From the curl equation of (2.1) and (2.2), the 

Maxwell’s equations will generate two modes,      

      Transverse electric (TEz): 

            
𝜕𝐻𝑍

𝜕𝑦
−

𝜕𝐻𝑦

𝜕𝑧
= 𝑗𝜔𝜀𝐸𝑥 

  (2.17) 

    
𝜕𝐸𝑥

𝜕𝑧
= −𝑗𝜔𝜇𝐻𝑦 

             (2.18) 
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−
𝜕𝐸𝑥

𝜕𝑦
= −𝑗𝜔𝜇𝐻𝑧  

(2.19) 

      Transverse magnetic (TM𝑧): 

                 
𝜕𝐸𝑍

𝜕𝑦
−

𝜕𝐸𝑦

𝜕𝑧
= −𝑗𝜔𝜇𝐻𝑥 

 (2.20) 

𝜕𝐻𝑥

𝜕𝑧
= 𝑗𝜔𝜀𝐸𝑦 

 (2.21) 

−
𝜕𝐻𝑥

𝜕𝑦
= 𝑗𝜔𝜀𝐸𝑍 

 (2.22) 

From the structure, the boundary condition at the interface between the two media 

requires the electric flux density to be continuous and the electric flux density𝐷(𝑦) =

𝜀𝐸𝑦, since there is no free charge and the permittivity is different on either side of 

the interface, which gives 𝐸𝑦 must be discontinuous across the interface. From the 

previous Maxwell’s equations only the TM mode has an electric field component 

that is normal to the interface, therefore TM polarization is the requirement for the 

excitation of surface phonon polaritons. If the wave is a surface wave, it must be 

confined to the surface. This can only happen if the field decays exponentially away 

from the interface.  

This implies the field solution has the following form. 

    �⃗� 𝑖(𝑧) = [
𝐸𝑦,𝑖

𝐸𝑧,𝑖
] 𝑒−𝜅𝑖|𝑦|𝑒𝑗𝛽𝑧 

             (2.23) 

�⃗⃗� 𝑖(𝑧) = 𝐻𝑥,𝑖𝑒
−𝜅𝑖|𝑦|𝑒𝑗𝛽𝑧              (2.24) 
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Where i=1,2 is for media 1, media 2 and 𝜅𝑖 is the decaying parameter. The wave 

equation for TM modes is  

              
𝜕2𝐻𝑥

𝜕𝑦2
+ (𝑘0

2𝜀 − 𝛽)𝐻𝑥 = 0 
(2.25) 

 

The expression 𝐻𝑥 has to fulfill the wave Eq. (2.25), take Eq. (2.24) into Eq. (2.25), 

yielding 

𝜅1
2 = 𝛽2 − 𝑘0

2𝜀𝑟,1        (2.26) 

𝜅2
2 = 𝛽2 − 𝑘0

2𝜀𝑟,2        (2.27) 

From the electric field boundary conditions which are, 

𝐸𝑧,1 = 𝐸𝑧,2        (2.28) 

−
𝑗

𝜔𝜀0𝜀𝑟,1𝜅1
(𝑘0

2𝜇𝑟,1𝜀𝑟,1 − 𝛽2)𝐻𝑥,1 =
𝑗

𝜔𝜀0𝜀𝑟,1𝜅2
(𝑘0

2𝜇𝑟,2𝜀𝑟,2 − 𝛽2)𝐻𝑥,2 
       (2.29) 

𝜅1

𝜀𝑟,1
+

𝜅2

𝜀𝑟,2
= 0 

       (2.30) 

Magnetic field boundary conditions, 

𝐻𝑥,1 = 𝐻𝑥,2     (2.31) 

−
𝑗𝜔𝜀0𝜀𝑟,1

𝜅1
𝐸𝑧,1 =

𝑗𝜔𝜀0𝜀𝑟,2

𝜅2
𝐸𝑧,2 

    (2.32) 

𝜀𝑟,1

𝜅1
+

𝜀𝑟,2

𝜅2
= 0 

    (2.33) 

Both conditions give us 𝜀𝑟,2 = −𝜀𝑟,1 𝜅2 𝜅1⁄  which means the surface waves exist 

only at interfaces between materials with opposite signs of the real part of the 
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dielectric permittivity. In other words, the SPhP requires a negative real part of the 

permittivity of the polar material and only a TM mode could excite surface phonon 

polaritons. 

Combining Eq. (2.26), (2.27) and (2.33) gives general dispersion relation of 

SPhPs propagating at the interface between the two dielectric medium, 

𝑘 = 𝑘𝑠𝑝ℎ𝑝 = (
𝜔

𝑐
)√

𝜀𝑆𝑃ℎ𝑃𝜀𝑎

𝜀𝑆𝑃ℎ𝑃 + 𝜀𝑎
 

    (2.34) 

Here, 𝜀𝑆𝑃ℎ𝑃  and 𝜀𝑎  are the complex permittivity of the phonon-polariton material 

(polar material) and the ambient medium, 𝑘0 = 𝜔 𝑐⁄  is the wave number for light.  

2.3 Finite element method 

The finite element method (FEM) is a numerical technique to solve complicated 

shapes structures which could be described by differential equations but these partial 

differential equations hardly be directly solved. However, the equation can be solved 

for the simple shapes like triangles, the finite element take advantage of this fact [52]. 

The single complicated shape could be replaced within approximately equivalent 

network of a simple element. In this research the FEM was applied to analysis the 

electromagnetic field associated with the hybrid waveguide system by dividing the 

entire structure into subdomains. As a result, FEM is manipulative mesh operation to 

minimize the error function deal with arbitrary refractive index profiles and 

complicated cross-sectional geometries. FEM mathematically finds the approximate 
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solution of partial differential equations derived from the wave equations for the 

waveguide by adding up all the subdomain solutions which could realize visualized 

field distributions. In the following, FEM is used to analyze the propagation 

characteristics of the waveguide. 

      The possible wave solution from the Maxwell’s equation is:   

𝐸(𝑥, 𝑦, 𝑧) = 𝐸(𝑥, 𝑦)𝑒−𝑖𝛽𝑧        (2.35) 

where β is the propagation constant, and the wave propagate along the z-axis.  

The vectorial wave equation can be written in the form of:  

∇2𝐸 + [𝑘2𝑛2(𝑥, 𝑦) − 𝛽2]𝐸(𝑥, 𝑦) = 0   (2.36) 

where ∇2= 𝜕2 𝜕𝑥2⁄ + 𝜕2 𝜕𝑦2⁄  , 𝑘 is the wave number 𝑘 = 2𝜋 𝜆0⁄ , 𝜆0 is the vacuum 

wavelength, and n(x,y) is the index distribution of the waveguide. As mentioned 

previously, the FEM can provide the approximate answer of the complex Eq. (2.36) 

over equivalent simple element equations with appropriate boundary conditions. The 

solution of the wave equation can be achieved by solving the E field that satisfies the 

stationary condition of the form: 

ψ[𝐸] =
1

2
∫ ∫ [(

𝜕𝐸

𝜕𝑥
)
2

+ (
𝜕𝐸

𝜕𝑦
)
2

− (𝑘2𝑛2 − 𝛽2)𝐸2] 𝑑𝑥𝑑𝑦
∞

−∞

∞

−∞

 
     (2.37) 

The mesh will be generated during solve process and the entire structure is divided 

into N discrete elements. Fig. 2.3 shows the mesh configuration of a three layers 

waveguide cross-section with N = 40598 discretized triangular elements. Note that 
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through iterative meshing smaller elements of higher density are implemented in 

regions where the fields have large gradients in order to improve the quality of the 

approximation without overburdening resource requirements. 

 

                                Fig. 2.3. FEM waveguide analysis. 

 

The electric field E⃗⃗ (x,y) in the ith element is approximated by a linear function of x 

and y : 

E(x, y)𝑖 = 𝑎0
𝑖 + 𝑎1

𝑖 𝑥 + 𝑎2
𝑖 𝑦        (2.38) 

where 𝑎0
𝑖 , 𝑎1

𝑖 , 𝑎2
𝑖  are constants for the element i, and can be determined based on the 

properties of the specific element. Each element is constructed by three nodal points 

generate triangular shape. At each nodal point, the electric field shares the same 

linear function with the appropriate x and y as in Eq. (2.37). The electric field 

distribution and the propagation constant for each element were calculated from the 

Eq. (2.37) and Eq. (2.38) of the entire domain is summarized in this form:  
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𝜓 = ∑𝜓𝐼

𝑁

𝐼=1

 

        (2.39) 

The effective index (𝑛𝑒𝑓𝑓) of the TM mode in the waveguide is determined by the 

relation 𝑛𝑒𝑓𝑓 = 𝛽𝜆0 (2𝜋)⁄ . Mesh is refined at sharply curved edges, abrupt changes 

in thickness, and structure with different material properties. Therefore, increasing 

the mesh number at certain area could achieve efficient accurate solution. 

Nonetheless, the calculation time will be increased. Therefore, the sufficient and 

appropriate applying mesh operation need to be consideration during the design.  

2.4 Eigenmode Solutions in HFSS 

In this dissertation, the Ansys HFSS (High Frequency Structure Simulator) is used, 

which is a 3D FEM electromagnetic simulation software for designing and 

simulating high-frequency electronic products. HFSS provides two types of solutions 

which are driven and eigenmode. The eigenmode solver is used in this hybrid 

waveguide design.  

Eigenmodes are the resonances of the structure. The eigenmode solver finds the 

resonant frequencies of the structure and the fields at those resonant frequencies. The 

standard eigenproblem is of the form [53]: 

𝐿Φ =  𝜆𝑀𝛷         (2.40) 
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Where L and M are differential, integral, or vector operators, Φ is the unknown 

eigenfunction to be determined, λ are the eigenvalues. In HFSS, eigenmode designs 

cannot contain design parameters that depend on frequency. If a material or boundary 

condition, varies with frequency, the eigenmode solution procedure will evaluate the 

frequency dependent property at the user specified minimum frequency. This may 

limit the accuracy of the solved eigenmodes depending on how significant the 

property varies from the minimum frequency to the eigen frequency. For every 

eigenmode solution setup, the number of eigenmode solutions that the solver finds is 

specified. The eigenmode solver can find up to 20 eigenmode solutions, can find the 

eigenmodes of lossy as well as lossless structures, and also can calculate the unloaded 

Q of a cavity. Q is the quality factor, it is a measurement of how much energy is lost 

in the system. Unloaded Q is the energy lost due to lossy materials and boundary 

conditions. Since sources are restricted for eigenmode problems, the Q calculated 

does not include losses due to those sources. HFSS uses the following equation to 

calculate the approximate quality factor. 

𝑄 =  |
𝑀𝑎𝑔(𝑓𝑟𝑒𝑞)

2 ∙ 𝐼𝑚(𝑓𝑟𝑒𝑞)
| 

         (2.41) 

Fig.2.4 shows an example of eigenmode solution in HFSS. 
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                                   Fig. 2.4. Eigenmode solution in HFSS. 

 

The frequency column in Fig.2.4 lists the real and imaginary parts of the frequency 

for each solved eigenmode.  For lossy eigenmode solutions, a Q column appears, 

which lists the unloaded quality factor Q computed for each eigenmode. 
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Chapter 3  

Infrared surface phonon polariton waveguides on 

SiC substrate 

3.1 Polar material SiC properties in reststrahlen band 

In this study, silicon carbide (SiC) has been used because at mid-infrared frequencies 

it has desirable material properties. Since its optical response is similar to metals, it 

is an alternative to metals; its real permittivity is negative and a sharp resonance near 

24THz (12.5μm) manifests itself by way of excitation of transverse optical phonons. 

This will result in a weaker damping and a corresponding sharper resonance. In 

addition, SiC offers the advantage that environmental conditions affect the lattice 

parameters, resulting in a change in the phonon polariton spectrum [54]. This enables 

a broad range of sensor-type applications for the detection of changing 

environmental parameters, such as temperature and pressure. The optical phonon 

resonances crystalline silicon carbide (4H-SiC) in the mid-IR spectral range is shown 

in Fig. 3.1 and the phonon polariton dispersion curve for 4H-SiC /air interface is 

shown in Fig. 3.2. 
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Fig. 3.1. Real (blue) and imaginary (red) parts of the dielectric permittivity 

of SiC. 

 

 

Fig. 3.2. Phonon polariton dispersion curve. The black curve demonstrated 

the bulk SiC dispersion relation and the red line is surface phonon polariton. 

The dashed horizontal lines indicate the LO and TO frequency locations. 

The red dashed diagonal line exhibit the dispersion of photons in air and in 

the high and low frequency limit of SiC in blue. 
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Analogous to metals, the dispersion relation can be approximated as a Lorentz 

oscillator for polar dielectric crystals [55]: 

ε(ω) = ε∞(1 +
ωLO

2 − ωTO
2

ωTO
2 − ω2 − iωγ

) 

             

(3.1) 

where 𝜔𝑇𝑂and 𝜔𝐿𝑂 are TO and LO phonon frequencies, respectively. In addition, 

hBN, c-BN, SiC, SiO2, Al2O3 and many Ш-N materials at certain frequencies could 

provide SPhP modes. 

3.2 Surface phonon polaritons (SPhPs) waveguides 

As mentioned previously, plasmonic waveguides can confine light in sub-

wavelength scale, it is useful for nanophotonic structures that can minimize the 

integrated circuit and enhance the efficiency of the spectroscopy. A hybrid plasmonic 

waveguide for subwavelength confinement structure is shown in Fig.3.3. It is 

constructed with a dielectric nanowire separated from a metal surface by a nanoscale 

dielectric gap. This hybrid waveguide provides the coupling between plasmonic and 

dielectric waveguide modes by trapping the energy in the low index dielectric gap 

with strong confinement. While it provides efficient propagation distance, however 

this structure is simulated at wavelength is 1550nm [1]. This design is not for the 

mid-infrared spectrum, however this work provides what many consider to be a 

seminal reference in hybrid waveguide analysis. 
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Fig. 3.3. Hybrid SPPs model [1]. A dielectric cylindrical nanowire of 

permittivity ε𝑐  and diameter d is separated from a metallic half-space of 

permittivity ε𝑚 by a nanoscale dielectric gap of permittivity ε𝑑 and width h. 

 

For mid-IR applications,  surface phonon polaritons take place of the SPPs when 

SiC replace the metal in the structure since the lattice vibrations of the polar dielectric 

couple with mid-IR electromagnetic wave to convey surface wave propagation in the 

hybrid waveguide. The boundary conditions require that the SPhPs only exist in TM 

modes. The behavior of SPhPs is analogous to both localized and propagating SPPs. 

The structure of a SPhP waveguide is shown in Fig. 3.4. By considering the 

fabrication constraints, SiC is usually modelled as a wafer having hundreds of 

microns thickness because it is hard to modify the size and shape of SiC; the new 

structure has been considered as a substrate. The design of a three layer configuration 

i.e., silicon wire on a benzocyclobutene (BCB) dielectric slab on SiC, and the effects 

of varying their dimensions on the modal field distribution and on the propagation 

length, are studied.   
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                         Fig. 3.4. Hybrid SPhP waveguide geometry. 

 

3.3 Propagating modes analysis 

The SPhP modes intimately rely on crystal lattice structures. Numerous potential 

geometries for SPP waveguides have been considered, whereas the study of SPhP 

waveguides has seen little activity such that there is potential for a wide range of 

unexplored designs and applications. Analogous to SPPs, the coupling between the 

SPhP modes into the hybrid waveguide modes results in field confinement within the 

dielectric gap.   

The dispersion relation for the SPhP is given by Eq. (2.34) and it can be split in 

to real and imaginary components. 
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kSPhP(ω) =
ω

c
(

εsphp
′ (ω)εa

εsphp
′ (ω) + εa

)

1
2⁄

+ j
ω

c
(

εsphp
′ (ω)εa

εsphp
′ (ω) + εa

)

2
3⁄ εsphp

" (ω)

2(εsphp
′ )

2 

      (3.2) 

where εsphp
′ (ω) is the real permittivity, εsphp

" (ω) is the imaginary permittivity of the 

SPhPs and εa is the permittivity of ambient medium. The propagation constant 𝛾 is a 

complex number that includes attenuation constant α and phase constant β. The 

propagation distance Lp can be defined as the distance a mode travels before decaying 

to e-1 of its original power [1, 56, 57],  

Lp =
1

2α
 

      (3.3) 

In addition to this, the attenuation constant, α = Im{ksphp}, so the Eq. (3.3) can be 

rewritten, 

Lp =
1

2Im{ksphp}
 

      (3.4) 

In addition to the propagation distance, the field confinement is another important 

parameter to identify the performance of the hybrid waveguide. 

The energy density can be derived from Poynting’s theorem in linear, lossy 

dispersive media,  

Wr =  
1

2
(𝑅𝑒 (

d(ε(r)ω)

dω
) |E(r)|2 + μ0|H(r)2|) 

      (3.5) 

Here E(r) and H(r) are the electric and magnetic fields, 𝜀(ω)  is the electric 

permittivity, 𝜇𝑜 is the magnetic permeability. 
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The modal area (Am) is defined as the ratio of the total modal energy per unit 

length to the peak energy density along the propagation direction [1].  

A =  
Wm

max{W(r)}
=  

1

max{W(r)}
∬W(r)d2r 

      (3.6) 

Mode confinement can be determined by the normalized mode area defined as 

Am Ao⁄   where Ao = λo
2 4⁄   and λo is the free space wavelength. This compares the 

mode area to the standard diffraction limit, as in dielectric waveguides. 

For a propagating wave consider the propagation constant γ described as γ = α +

jβ and the complex effective refractive index of the mode Neff is given by, 

Neff =
γ

β0
=

α

β0
+

jβ

β0
= keff + jneff 

      (3.7) 

where β0 = 2π λ0⁄  is the phase constant of plane waves in free space and 𝜆0 is the 

free space wavelength.  

For single-interface SPhP, useful expressions are used [58], 

neff =
β

β0
≅ (

εsphp
′ (ω)εa

εsphp
′ (ω) + εa

)

1
2⁄

 

          (3.8) 

 

keff =
α

β0
≅ (

εsphp
′ (ω)εa

εsphp
′ (ω) + εa

)

2
3⁄ εsphp

" (ω)

2(εsphp
′ )

2 

          (3.9) 
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As shown in previous structures of hybrid surface phonon polariton waveguide, the 

effective refractive index is non-linearly dependent on the height of the dielectric gap 

h and the width of the dielectric wire width w.  

3.4 Waveguide configuration and numerical simulations 

We apply an eigensolver simulation approach in Ansys HFSS, with validation of the 

method in [59] where results in [41] based on semi-analytical methods of lines were 

reproduced. We can achieve efficient complex eigen frequencies by changing the 

phase delay between the boundaries parallel to the propagation direction, whereas 

the remaining boundaries are combinations of perfect electric and magnetic walls 

placed 9λ0 from the wire to leave the hybrid modes unperturbed. The different view 

of the design is shown in Fig. 3.5 and the simulation of unit cell in HFSS is shown 

in Fig. 3.6. 

 

              Fig. 3.5. Different view of the hybrid waveguide structure. 
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                             Fig. 3.6. Analysis model of a unit cell. 

 

By tuning the geometry of the structure, we can achieve reasonable propagation 

length and maintain moderate field confinement. As shown in Fig.3.5 the three-

layered hybrid waveguide constructed by the high permittivity rectangular Si wire 

εSi = 11.7 (rectangular waveguide) attached on a low permittivity dielectric BCB 

spacer with permittivity εBCB = 2.3 on top of a SiC wafer with permittivity  εSiC =

−30.55 + i1.5 (phonon waveguide) . The material properties need to be assigned, 

we use SiC as an example. First, open the material browser by clicking ‘Tools’, then 

click the ‘Materials’, in our design SiC is an isotropic and frequency dependent 

material not available in the material library, therefore we need to click the 
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‘View/Edit Materials’. Second, in the first line type in the relative permittivity for 

SiC. Similarly, the dielectric loss tangent is provided. The example for the SiC 

property assignment is shown in Fig. 3.7.  

 

                          Fig. 3.7. SiC property editing in HFSS. 

 

We have analyzed the influence of the width of the silicon wire (w) on the 

propagation characteristics of the hybrid SPhP waveguide. If w is set below 2.25µm, 

we can get lower propagation loss, however, the field would be weakly confined. In 

contrast, if w is larger than 2.25µm, the mode will be more Si-wire like. In the 
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following result, w is fixed at 2.25µm and the rectangular wire height h and the 

spacer height between the wire and the SiC wafer d are varied. The propagation 

length L (μm), mode area Am and electromagnetic field distribution at wavelength, 

λ=12μm are presented. 

 

Fig. 3.8. Modal area, Am A0⁄ versus the Si thickness h for different thickness 

of the BCB layer d. 

 



34 

 

 

Fig. 3.9. The hybrid mode’s propagation distance versus the Si thickness h 

for different thickness of the BCB layer d.  

 

 

Fig. 3.10. (a) Complex magnitude of H for [h,d] = [1.35,1]μm. (b) [h,d] = 

[1.35,1.5]µm. (c) [h,d] = [1.35,2]µm. (d) [h,d] = [1.35,2.5]µm. (e) [h,d] = 

[2.65,1]µm. (f) [h,d] = [2.65,1.5]µm. (g) [h,d] = [2.65,2]µm. (h) [h,d] = 

[2.65,2.5]µm. 
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Figure 3.8 and Fig. 3.9 shows the dependence of normalized modal area and 

propagation distance. For large h, the hybrid waveguides that tend to support low-

loss rectangular dielectric waveguide modes with electromagnetic filed are mainly 

confined in the high-permittivity Si wire [Fig. 3.10(e)-(h)]. In this case, the 

propagation length is much bigger than other modes, but at the cost of much larger 

mode area (low confinement). At moderate dimensions of h and d, mode coupling 

results in a new hybrid mode that shows both Si wire and SiC phonon modes; the 

magnetic intensity field is distributed over both the Si rectangular waveguide and the 

SiC-BCB interface [Fig. 3.10(a)-(d)]. By keeping the height of Si to be 1.35μm and 

increasing the height of the BCB spacer d, we can achieve increase in propagation 

length from 151.06μm to 222.67µm while still keeping the hybrid mode confined 

[Fig. 3.10(a)-(d)]. We have seen that from the normalized mode area, the lowest 

mode area is near h = 1.5μm, for all variations of  d. Besides, lower refractive index 

of the inner BCB dielectric layer will ensure relatively lower propagation loss 

because the field inside the SiC would much weaker. 

3.5 Comparison with the hybrid waveguide at different wavelength 

From the previous section, it has been shown that the hybrid SPhP waveguide was 

able to guide the SPhP modes with favorable mode area and propagation distance 

due to the involvement of low loss dielectric BCB and interaction with negative 

permittivity SiC coupling with high index Si. We are also interested in the hybrid 
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mode characteristics including mode confinement and propagation distance at other 

wavelengths. The comparison of the field distribution demonstrates at 11.17µm, 

11.78µm and 12µm and is shown in Fig.3.11 for dielectric BCB spacer equal to 

0.25μm and 2μm. 

 

 

Fig. 3.11. H-Field distribution for d = 0.25μm (a) and d = 2μm (b). 
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We have seen that the field distribution is not confined for short Si height but the 

strongest field is in the BCB spacer in Fig. 3.11(a) top row, by increasing the 

wavelength there are more fields that are unbounded from the structure. But by 

increasing the height of Si and keeping other dimensions the same, the field is 

concentrated close to the spacer. We find that the propagation length in the 

waveguide at 12μm is 416.65μm, which is longer when compared to 11.61μm at 

λ=11.17μm. Fig. 3.11(a) bottom row, there is a decrease of the propagation length 

with increase in frequency, which can be predicted mathematically and consequently 

numerically by Eq. (3.4). From Fig. 3.11(b) top row, it is seen that that the phonon 

mode strength increases by increasing the wavelength. At appropriate dimensions 

the hybrid mode exists, however more hybrid modes can be formed at λ=11.17μm 

but the propagation distance is much less than the hybrid modes at λ=12μm. Mode 

area seems to be keeping in with the same trend. This means that the hybrid 

waveguide has good performance at lower frequencies. An interesting observation is 

that, propagation lengths deteriorates at wavelengths closer to the phonon resonance 

of SiC. 

3.6 Conclusion 

A hybrid surface phonon polariton waveguide by coupling Si and SiC based phonon 

modes through finite element analysis using an eigenmode solver has been proposed. 
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By controlling the hybridization of the fundamental mode of a rectangular dielectric 

wire (Si) and the phonon mode of a dielectric-negative permittivity material (SiC), 

we achieve field confinement and long-range propagation. The result has been shown 

that for free-space wavelength λ = 12μm, propagation length L = 18.55λ = 222.6μm, 

while maintaining well-confined modes. Also by comparing the modal area and 

propagation length for different wavelengths 𝜆 = 11.17μm, 𝜆 = 11.78μm, 𝜆 = 12μm, 

the best performance of field distribution and propagation distance appears to be for 

𝜆 = 12μm. 
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Chapter 4   

Hybrid phononic waveguide using hyperbolic 

boron nitride 

4.1 Hexagonal boron nitride properties 

Boron nitride (BN) is a wide band gap III-V compound with prominent chemical 

stability and physical properties. Hexagonal BN (h-BN) is composed of alternating 

boron and nitrogen atoms in a honeycomb arrangement, consisting of sp2 –bonded 

two-dimensional (2D) layers [60]. Similar to graphite, each layer of h-BN are held 

together by weak van der Waals forces while boron and nitrogen atoms are bound by 

strong covalent bonds. Figure 4.1 shows the hexagonal boron nitride structure [61].  

 

Fig. 4.1. The crystal lattice of hexagonal boron nitride consists of hexagonal 

rings forming thin parallel planes. Atoms of boron (B) and nitrogen (N) are 
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covalently bonded to other atoms in the plane with the angle 120˚ between 

two bonds. The planes are bonded to each other by weak van der Waals 

forces [61]. 

 

Therefore, by using micromechanical cleavage [62, 63, 64] on bulk BN crystal, h-

BN films could be achieved. Few-layer h-BN can also be fabricated by 

ultrasonication [65] and high-energy electron beam irradiation of BN particles [66]. 

The ability to deposit one atom thick unit cells of h-BN, essentially producing two 

dimensional surfaces that support SPhPs [67, 68, 69].  

Boron nitride is a naturally hyperbolic dielectric material exhibiting a hyperbolic 

dispersion whose permittivity tensor possesses both positive and negative principal 

components. Being a typical low loss and anisotropic material, h-BN exhibits two 

reststrahlen bands in the mid infrared spectrum: (1) at lower frequency (Type I 

reststrahlen band ω = 746 − 819 cm−1), the real part of out-of-plane permittivity is 

negative (ε‖ < 0) and the in-plane permittivity is positive (ε⊥ > 0); (2) at higher 

frequency (Type II  reststrahlen band ω = 1370 − 1610 cm−1), the real part of out-

of-plane permittivity is positive (ε‖ > 0) and the in-plane permittivity is negative 

(ε⊥ < 0) [69, 70, 71]. Considerable work has been done to classify these resonances 

into a distinct lower frequency (Type I) and upper frequency (Type II) reststrahlen 

band. h-BN possesses a strong surface phonon resonance resulting from a negative 

permittivity in the upper reststrahlen, or in-plane, band. The plots of the derived 

permittivity components Re 𝜀⊥ (green curve) and Re 𝜀‖ (magenta curve) presented 
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in Fig. 4.2 verify that Re 𝜀‖ < 0,  Re 𝜀⊥ > 0 in the lower band ( λ ≈ 12.1-13.2μm) 

while Re 𝜀⊥ < 0, Re 𝜀‖ > 0 in the upper band (λ ≈ 6.2-7.3μm) [49].  

 

Fig. 4.2. Derived real parts of the permittivity tensor components of h-BN. 

The Type I lower and II upper reststrahlen band are shaded [49].  

 

The excitation and control of these phonons has been studied in [67, 68, 69, 72, 73, 

70]. Due to the large spectral separation between the out-of-plane and in-plane 

phonon resonance they are decoupled and do not interfere with one another. In order 

to enhance absorption/transmission and field confinement of h-BN polaritons in the 

areas of sensing and detection, graphene-based h-BN surface plasmon phonon 

polaritons have been used [74, 75, 76, 77, 78]. The high-field confinement of the 

tunable graphene plasmons in mid-IR allows for strong coupling with the h-BN 
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monolayers. However, h-BN structures have not been integrated into hybrid designs 

for mid-IR waveguide applications. At wavenumber 1400 cm-1, in the in-plane 

reststrahlen band, the magnitude of the h-BN permittivity is far greater than that of 

the air.  Hence little evanescent field resides in the h-BN region and most of the wave 

energy flows through the air, significantly reducing, but not entirely eliminating 

volumetric losses inside the layer. We carried out initial calculations to estimate 

performance of h-BN as a SPhP supporting candidate. Figure 4.3 depicts the 

computed dispersion curves of SPhP at a flat h-BN/air interface in the in-plane 

resonance band. Figure 4.3(inset) shows the region of interest where the data markers 

represent the wavenumbers at 1400 cm-1, 1426 cm-1 and 1483 cm-1.   

 

           Fig. 4.3. Dispersion of the SPhP mode of the flat h-BN-air boundary. 
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4.2 Geometry and modal properties for the proposed hybrid phononic 

waveguide 

A hybrid phononic waveguide design by coupling h-BN SPhPs with a dielectric 

waveguide is shown in this section. For the purpose of a hybrid waveguide, we 

operate around the in-plane resonance owing to the strong surface phonon response 

on h-BN slab [49]. The hybrid SPhPs propagate over large distances (up to two orders 

of magnitude more than the operational wavelength) with modal confinement as low 

as ~10-3 λ2. This approach yields significant improvements to both guided phononics 

and photonics and has applications in phonon based IR lasers, bio-sensing and 

interferometry [79] [80] [81]. 

 

Fig. 4.4. The hybrid mid-IR waveguide which includes a dielectric cylinder 

of diameter d placed at a gap height h above an h-BN slab on a dielectric 

substrate.   
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Figure 4.4 depicts the proposed hybrid phononic waveguide structure. A high-

refractive-index dielectric cylinder waveguide with diameter d is placed above the h-

BN slab with nanoscale air gap distance h. The cylinder waveguide is silicon with 

refractive index n = 3.42, and the h-BN slab with an in-plane permittivity ε⊥ = -

28.12+2.91i and out-of-plane permittivity ε∥ = 2.73+0.0004i at mid-IR wavenumber 

1400 cm-1. The simulated SPhP mode is along the interface between air and a 1 μm 

thick h-BN slab on a dielectric substrate. The interface of h-BN/air supports surface 

waves in the form of SPhPs as designated by the strong field concentration above the 

slab. Note that here we only consider the fundamental mode, since higher order 

modes will only exist in ultrathin h-BN [69]. The h-BN based hybrid phononic 

waveguide with an air gap presented here can be implemented in suspended 

waveguide designs akin to those seen in [15]. 

In the following study, we vary the cylinder diameter, d, and the air gap, h, to 

control the propagation distance, Lm, and modal area, Am, while maintaining a 

transverse magnetic field distribution. The strong mode-coupling in the air gap 

between the dielectric waveguide cylinder mode and the SPhP mode results in an 

extremely confined hybrid phononic mode. The entire structure lies on a lossless 

dielectric substrate of permittivity εd = 2.25. It should be noted that SPhP modes can 

be supported by this h-BN/substrate boundary however in this work we are 

considering modes in which this additional SPhP mode is suppressed such that the 

air/h-BN SPhP and the cylinder mode dominate the hybrid coupling. 
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Figures 4.5(a) and (b) show the modal area Am and the propagation length Lm of 

the hybrid phononic mode as a function of the waveguide diameter d and the air gap 

h. The propagation length Lm and the modal area Am are calculated from Eq.3.4 and 

Eq.3.6, 

Lm = [2Im(khyb(d, h))]
−1          (4.1) 

Am =
Wm

max{W(r )}
 

 

         (4.2) 

where khyb(d, h) is the wavevector of the hybrid mode and 𝑊𝑚  is the integrated 

electromagnetic energy over the modal distribution. 𝑊(𝑟 ) is the local energy density 

at the position 𝑟  given by Eq 3.5. Mode confinement can be gauged by the 

normalized modal area defined as Am Ao⁄  where Ao = λo
2/4 and λo is the free space 

wavelength. 
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Fig. 4.5. (a) Modal area as a function of cylinder diameter d for different 

gap height h. (b) Hybrid propagation distance as a function of cylinder 

diameter d for different gap height h.  
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Figure 4.6 shows the electromagnetic energy density distributions of the hybrid 

phononic mode for different waveguide diameter d and air gap h. For large d and h 

(for example, [d,h] = [2.5, 1] μm), the hybrid phononic waveguide supports a low-

loss cylinder-like mode with optical energy confined in the dielectric cylinder. 

Conversely, a small diameter d results in a SPhP-like mode with very weak 

localization on the h-BN/air interface, suffering loss comparable to that of uncoupled 

SPhPs. At other cylinder diameters (for example, [d, h] = [1.4, 0.25] μm and [1.4, 

0.1] μm), mode coupling results in a hybrid mode that has both cylinder and SPhP 

features i.e., its electromagnetic energy is distributed in the cylinder waveguide, the 

h-BN/air interface and inside h-BN slab. For h in nanometer scale, for example [d, 

h] = [1.4, 0.01] μm, the cylinder mode is strongly coupled to the SPhP mode, most 

of the optical energy being concentrated inside the air gap with ultrasmall modal 

area. The air gap between the cylinder dielectric waveguide and the h-BN slab 

provides a region of low-index material that can be used to strongly confine and 

propagate light. This arises from the need to satisfy the continuity of the normal 

component of electric flux density, D, giving rise to a large amplitude of normal 

component of electric field in the low-index region of a high-index-contrast interface 

[82]. Also, the uncoupled SPhP and dielectric geometries amplify this effect by 

having dominant normal electric field components to the material interfaces.   
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Fig. 4.6. Electromagnetic energy density distribution for (a) [d, h] = [2.5, 1] 

μm, (b) [d, h] = [1.4, 0.25] μm, (c) [d, h] = [1.4, 0.1] μm and (d) [d, h] = 

[1.4, 0.01] μm. 
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4.3 Coupling characteristics between surface phonon polariton and 

dielectric waveguide 

In order to explain the coupling between SPhP and dielectric cylinder modes, we 

analyzed the dependence of the hybrid mode’s effective index, nhyb(d, h) on d and 

h. Figure 4.7 depicts the effective index of the hybrid mode on d for different gap 

height h. As expected, the waveguide mode index approaches that of the dielectric 

cylinder mode and SPhP mode at the extremities of the plot. Meanwhile, the hybrid 

mode’s effective index is always larger than dielectric cylinder mode and SPhP 

mode, indicating that the SPhP mode is coupled with the dielectric cylinder 

waveguide, which induces a much higher effective index. The mode’s effective index 

can be increased by reducing the gap distance for a fixed d, or enhancing the diameter 

of the cylinder nanowire, d, for a fixed gap distance, h. This can be explained by the 

observation that the coupling efficiency is increased between the cylinder and h-BN 

surface when the d increases or h reduces. 
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Fig. 4.7. Effective index of the hybrid waveguide for different gap height h 

versus cylinder diameter d. The dashed line indicates the index of the SPhP 

mode nSPhP. 
 

In order to explain the coupling efficiency with coupled mode theory, we describe 

the hybrid eigenmode as the superposition of the cylinder waveguide mode 

(without h-BN slab) and the SPhP mode (without cylinder) [1]. 

ψhyb(d, h) = a(d, h)ψcyl(d) + b(d, h)ψSPhP 

 

     (4.3) 
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Here a(d, h) and b(d, h) are the mode amplitudes of the cylinder mode 𝜓𝑐𝑦𝑙 and 

the SPhP mode ψSPhP , respectively, and with b = (1 − |a|2)1/2. The coupled 

waveguide system can be described as [1], 

ncyl(d)a(d, h) + κ(d, h)b(d, h) = nhyb(d, h)a(d, h)      (4.4) 

κ(d, h)a(d, h) + nSPhPb(d, h) = nhyb(d, h)b(d, h)      (4.5) 

where ncyl(d) and 𝑛𝑆𝑃ℎ𝑃  are the effective index of the cylinder mode and SPhP 

mode, respectively, and  nhyb(d, h) is the effective index of the waveguide mode. 

According to the coupled-mode theory for the hybrid waveguide, the coupling 

strength κ(d, h) between these two modes can be described as 

κ(d, h) = √(nhyb(d, h) − nSPhP)(nhyb(d, h) − ncyl(d)) 
     (4.6) 

Figure 4.8 plots the dependence of coupling strength κ on d and h for the hybrid 

mode. The coupling strength is maximum when the index of the cylinder mode 

equals that of the SPhP mode, which can be seen analytically from Eq. (4.6). At a 

critical diameter dc for each gap height h, the coupling strength hits its maximum 

value when the cylinder mode and SPhP mode propagate in phase and the effective 

optical capacitance of the hybrid system is maximum. We can see from Fig. 4.8 that 

the coupling strength increases with decreasing gap distance h, which can be 

correlated with the fact that the modes couple more effectively as the gap size is 

reduced. Note that in Fig. 4.5(a), an uncharacteristic bump in modal area and a 

corresponding dip in propagation length [Fig. 4.5(b)] can be observed which could 
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be attributed to maximum coupling strength between the dielectric cylinder and the 

h-BN slab modes, causing volumetric loss in h-BN which manifests itself as well 

confined hyperbolic polaritons (HPs). 

 

Fig. 4.8. The dependence of coupling strength κ on cylinder diameter d and 

gap height h. 
 

As seen in the dispersion diagram of h-BN from Fig. 4.3, the SPhP mode holds a 

relatively high effective index and confines the fields tightly, which suggests that as 

the dispersion curve deviates from the light line, the SPhP mode begins to get more 

confined on the surface of h-BN slab. This effect can also factor into the hybrid 

waveguide, where stronger field confinement is achieved at larger wavenumbers. 
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This is illustrated in Fig. 4.9, where normalized electromagnetic field density is 

plotted for a fixed gap and cylinder diameter, for three different wavelengths. We 

clearly see that for the largest wavenumber 1483 cm-1, the largest amount of energy 

is highly confined within the gap between the cylinder and the h-BN slab, while for 

the shortest wavenumber 1400 cm-1, the least amount of energy lies in the gap.    
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Fig. 4.9. Normalized energy density along z axis at wavenumber (a) 1400 

cm-1 (b) 1426 cm-1 and (c) 1483 cm-1. (d) Normalized energy density at z = 

-d/2 for different wavenumbers.  

 

Moreover when the coupling strength is maximum at the three different 

wavenumbers, as mentioned before, strong field penetration can be observed inside 

the h-BN slab, giving rise to HPs, which is a sub-diffraction-limit phenomenon 

observed in h-BN. These HPs follow angular propagation along the y-direction, seen 

in Fig. 4.10(a), where the angle depends on the ratio of the extraordinary axis (z-axis) 

and ordinary (x-y plane) components of the anisotropic dielectric function of h-BN, 

as given by [70], 



56 

 

𝜃 =
𝜋

2
− arctan (

√𝜀𝑧(𝜔)

𝑖√𝜀𝑥𝑦(𝜔)
) 

     (4.7) 

Figure 4.10(b) shows the dependence of HP propagation angle versus 

wavenumber, where the solid blue line is computed from Eq. (4.7). The data markers 

represent the propagation angles at different wavenumbers from the simulation 

results (θ1 at 1400 cm-1, θ2 at 1426 cm-1 and θ3 at 1483 cm-1), which are in good 

agreement with the corresponding computed propagation angles from Eq. (4.7). 
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Fig. 4.10. (a) Critical angle θ of the hyperbolic polaritons propagating inside 

the h-BN slab at 1400 cm-1 for [d, h] = [1.4, 0.1] μm. (b) Frequency-

dependent directional angles of the hyperbolic polaritons, where θ1 is at 

1400 cm-1, θ2 at 1426 cm-1 and θ3 at 1483 cm-1. 

 

4.5 Conclusion 

We have designed a hybrid surface phonon polariton waveguide using a dielectric Si 

cylinder placed at a height above a hyperbolic boron nitride slab on a substrate. The 

resulting hybrid mode can propagate distances of up to more than two orders of 

magnitude above the operational wavelength, with normalized modal area of ~10-3 

𝜆2,  which opens the way for various optomechanical applications in mid-IR such as 

nanoscale tweezers to trap nanoparticles (chemical species that have resonances in 
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this region) analogous to those seen in the optical regime [82] and near-field optical 

imaging, waveguiding and focusing applications [49, 41]. Moreover, planar h-BN 

has proven easy to fabricate and incorporate on a variety of substrates; the air gap 

can also be substituted with a low loss, low index dielectric spacer which makes for 

easily realizable fabrications. Our work fulfills the apparent need for phononic 

waveguiding in integrated polaritonics and next-generation devices operating in the 

THz spectrum. 
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Chapter 5  

Hybrid long-range hyperbolic phonon polariton 

waveguide using hexagonal boron nitride for mid-

infrared subwavelength confinement 

5.1 Introduction 

Plasmonics and semiconductor photonic technologies have already revolutionized 

communications [83, 84] and have potential capabilities in spectroscopy, chemical 

and biological sensing as well as subwavelength laser devices [85, 86]. Manipulating 

light on scales much smaller than the wavelength and achieving high-density 

integration of optical devices remain critical challenges in micro- and 

nanotechnology. Surface plasmon polaritons (SPPs) are regarded as promising 

candidates for guiding and confining light at the subwavelength scale at optical and 

near-infrared (IR) wavelengths [87]. In order to minimize the high optical loss of 

SPP waveguides, a hybrid plasmonic waveguide, which consists of a dielectric 

nanowire separated from a metal surface by a nanoscale dielectric gap, has been 

investigated [1, 57]. For further improvement of the mode confinement and 

propagation distance, long-range hybrid surface plasmon polariton waveguide 

structures have been presented [4, 88, 89, 90]. However, due to the intrinsic Ohmic 

loss of noble metals, the advantages of SPPs are prohibitive at mid-infrared (mid-IR) 
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wavelengths. An infrared counterpart to the SPP is the surface phonon polariton, 

which results from the coupling of lattice vibrations (or phonons) of a polar dielectric 

crystal to incident mid-IR radiation [91]. The mid-IR spectrum is rich with 

vibrational and rotational molecular resonances which, when coupled to 

electromagnetic fields, provide informative probes that reveal spectroscopic material 

characteristics [85]. Phonon polaritons could also provide potential applications for 

high-density IR data storage [8], infrared phononic nanoantennas [92] and IR 

imaging [79, 41]. The need for low-loss, subwavelength confinement and 

propagating modes in mid-IR nanostructures has motivated research into phonon-

polariton based waveguiding.  

Hyperbolic phonon polaritons (HPhPs) [93] exhibit a hyperbolic dispersion 

whose permittivity tensor possesses both positive and negative principal 

components. Owing to their strong confinement and enhancement of electromagnetic 

fields beyond the diffraction limit scale, HPhPs have gained a lot of attention recently 

[49, 31, 32, 94]. Of particular interest is hexagonal boron nitride (h-BN), a typical 

van der Waals (vdW) material that exhibits natural hyperbolic dispersion which 

compensates the shortcomings of artificial hyperbolic metamaterials, such as high 

plasmonic losses and complex nanofabrication [31, 32]. Another fascinating property 

of h-BN is that single-atom thick flakes can be achieved through standard exfoliation 

techniques [94]. It has been experimentally demonstrated that h-BN nanotubes can 
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support one-dimensional surface phonon polaritons with deep-subwavelength field 

confinement in the mid-IR [95].  

Recent research has studied insulator-hyperbolic boron nitride-insulator (IHI) 

structures in the Type II reststrahlen band [19]. The IHI structure has been shown to 

support long-range propagating polariton modes with propagation lengths higher 

than a Ag/MgF2 hyperbolic metamaterial waveguide [19]. H-BN has been considered 

as an alternative to hyperbolic metamaterials due to its naturally occurring hyperbolic 

dispersion and low loss characteristics in the infrared spectral region [19]. In this 

paper, we propose a hybrid long-range hyperbolic phonon polariton (LRHPhP) 

waveguide consisting of two identical dielectric cylindrical wires placed 

symmetrically about a h-BN slab embedded in a low-permittivity dielectric medium 

in the Type II reststrahlen band. To the best of the authors’ knowledge, this paper 

shows for the first time the implementation of recently theoretically-reported [19] 

long-range HPhP modes in a mid-IR hybrid waveguide using a h-BN slab. 

Three-dimensional (3-D) simulations based on finite-element-method (FEM) 

using Ansys HFSS eigenmode solver are performed to calculate the field 

distributions. To improve the accuracy of the eigenmode results, sufficiently large 

dimensions in both the horizontal and vertical directions of 9λ0 by 6λ0, respectively, 

are used. In addition, measured dispersive material properties of h-BN provided by 

the US Naval Research Laboratory are imported in the model [49]. In [18], Xu et al. 



62 

 

claims to achieve a hybrid waveguide using h-BN resulting from the coupling 

between type II surface phonon-polaritons in h-BN and a single high index dielectric 

cylinder. With the use of volumetric LRHPhP in h-BN, the proposed design can 

achieve three orders of magnitude longer propagation length while maintaining a 

similar degree of modal confinement as compared with the work by Xu et al. in [18]. 

This approach allows for ultra-compact and sensitive mid-IR waveguides with 

applications in sensing, spectroscopy, and lab-on-chip systems [41]. The hybrid 

waveguide approach utilizes field enhancement [96], which results in the shrinking 

of the polariton wavelength, from the phonon polaritons to reduce modal area. This 

paper is organized as follows: the properties of short and long-range h-BN HPhPs 

are analyzed and the hybrid LRHPhP waveguide properties are characterized in 

terms of the guide geometry parameters in section 5.2. In section 5.3, the 

hybridization analysis through coupled-mode theory is discussed. The conclusions 

are presented in section 4. 

5.2 Geometry and modal properties for the proposed hybrid phononic 

waveguide 

Figure 5.1 illustrates the structures of the hybrid long-range phonon polariton 

waveguide. Two identical high refractive index dielectric cylinder wires are 

symmetrically placed on each side of a thin h-BN slab with a small gap distance h. 

The LRHPhP mode that exists in this structure is a transverse magnetic (TM) mode 
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that propagates in the z direction. The cylindrical wires with diameter d are gallium 

arsenide (GaAs) which has a negligible material loss in the window around 6.6μm 

with refractive index n = 3.5 [1] and the h-BN slab has thickness t = 0.5µm with in-

plane permittivity 𝜀⊥ = −3.38 + 0.19𝑖  and out-of-plane permittivity 𝜀∥ = 2.77 +

0.0003𝑖 at mid-infrared wavelength 6.6μm. Using the HFSS eigenmode solver, a 

thin cross-sectional slice of the geometry under consideration is taken. Master and 

slave boundaries are placed on the cross-sectional faces to extend the waveguide to 

infinity. Resulting resonant modes with a given complex eigen frequency are 

determined for a given phase delay between the master and slave boundaries. The 

quality factor, Q, of the eigenmode is used to determine the propagation length. 

Similarly, the phase delay between the master and slave boundaries is used to 

determine the real part of the complex index. The h-BN based hybrid phononic 

waveguide embedded in uniform dielectric medium air proposed here can be 

achieved in suspended waveguide techniques analogous to those seen in [15]. For 

easily realizable fabrication, the air gap can also be substituted with a low-index and 

low-loss dielectric spacer similar to that reported in [97] by Oulton et al. The 

diameter of the dielectric nanotube d, the gap height h and h-BN film thickness t can 

be controlled with high accuracy [69, 97, 98] which indicates the fabrication 

tolerance requirements are feasible. 
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Fig. 5.1. Schematic illustration of the proposed hybrid long-range phonon 

polariton waveguide which includes two identical GaAs cylinder wires with 

diameter d symmetrically placed on each side of a thin h-BN slab are 

separated with a spacer height h. The h-BN slab has thickness of t and this 

waveguide is embedded in air at mid-infrared wavelength 6.6μm. 

 

Before conducting hybrid waveguide analysis, we characterized the hyperbolic 

phonon polaritons that exist in an h-BN thin slab. Both the hybrid long-range and 

hybrid short-range HPhP refractive indices and propagation lengths are shown in Fig. 

5.2. The propagation length of the hybrid phononic mode as a function of the wire 

diameter d and the air spacer height h is given by Lm = [2Im(khyb(d, h))]
−1

, where 

khyb(d, h) is the wavenumber of the hybrid mode [1]. The long- and short-range 

HPhPs are akin to the respective long- and short-range modes in thin metal slabs that 

support SPPs [99, 100, 101, 102]. For this thin hyperbolic h-BN slab surrounded by 

uniform dielectric medium in the Type II reststrahlen band there exists a symmetric 
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mode and an anti-symmetric mode. The symmetric mode is the so-called long-range 

hyperbolic phonon-polariton (LRHPhP) mode providing long propagation distance 

with weak mode confinement and the anti-symmetric mode represents the short-

range hyperbolic phonon polariton (SRHPhP) mode which provides shorter 

propagation distance with stronger mode confinement [19]. The dielectric cylinder 

wire mode couples with both modes, compensating the weak modal confinement of 

the pure LRHPhP mode and reducing the pure SRHPhP mode’s modal area. Here the 

diameter of both cylinders are kept constant at d =1µm. Figure 5.2(a) shows the 

effective index varying with the thickness of the h-BN slab. As the h-BN slab 

thickness t increases, tending toward bulk behavior, the short- and long-range 

phonon polariton modes start to converge. Different colors of the effective index 

curve represent different spacer heights h in each waveguide. The dashed curves with 

increasing effective index as t decreases represent the SRHPhPs and solid curves 

represent LRHPhPs in Fig. 5.2(a). Figure 5.2(b) shows the propagation lengths for 

this waveguide for h-BN slab thickness less than 3µm. The LRHPhP modes in each 

case of the waveguide consistently has several orders of magnitude longer 

propagation length than that of SRHPhP modes. Therefore, the symmetric mode is 

of interest in this study since it supports much longer propagation lengths. 
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Fig. 5.2. (a) The effective indices as a function of h-BN slab thickness t for 

hybrid and non-hybrid LRHPhP and SRHPhP waveguides. (b) The 

propagation distance for hybrid and non-hybrid LRHPhP and SRHPhP 

changing with t. The solid lines and broken lines represent long- and short-

range HPhPs, respectively. The colored curves (red and green) represent 
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hybrid waveguides for different spacer heights h. The black lines represent 

a h-BN thin slab embedded in low dielectric material exhibiting long and 

short range HPhPs. 

 

In the following study, we choose h-BN slab thickness t = 0.5µm and we vary the 

cylinder wire diameter d and the dielectric spacer height h between the cylinder and 

the h-BN slab to manipulate the propagation distance Lm and modal area Am while 

maintaining the electromagnetic field distribution of a single hybrid mode at 

wavelength 6.6μm.  The modal area, Am, is defined as the ratio of the total mode 

energy to the peak energy [1], 

𝐴m =
𝑊𝑚

𝑚𝑎𝑥{𝑊(𝑟 )}
=

1

𝑚𝑎𝑥{𝑊(𝑟)}
∬ 𝑊(𝑟)𝑑2𝑟

∞

−∞

 (5.1) 

 

where Wm is the electromagnetic energy W(r) and is the energy density (per unit 

length along the direction of propagation) given by, 

𝑊(𝑟 ) =
1

2
𝑅𝑒 {

𝑑(𝜔𝜀(𝑟 )

𝑑𝜔
} |𝐸(𝑟 )|2 +

1

2
𝜇0|𝐻(𝑟 )|2 (5.2) 

The normalized mode area is defined as 𝐴𝑚 𝐴𝑜⁄ to characterize the mode 

confinement, where 𝐴𝑜 = 𝜆0
2 4⁄  is the diffraction-limited area in free space. 
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Fig. 5.3. (a) Normalized modal area (𝐴𝑚/𝐴𝑂) versus cylinder wire diameter 

d for different spacer height h (colored lines), compared with a pure cylinder 

mode (black line). (b) Hybrid propagation distance versus cylinder wire 
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diameter d for different spacer height h (colored lines), compared with 

LRHPhP modes in Air-hBN-Air is denoted by the black dashed line. 

 

 

Fig. 5.4. Electromagnetic energy density distribution for (a) [d,h] = [2.5, 

0.25] μm, (b) [d,h] = [1, 0.25] μm, (c) [d,h] = [1, 0.01] μm and (d) [d,h] = 

[1.5, 0.01] μm. The lower right-hand corner shows the magnetic field 

vectors for the hybrid LRHPhP waveguides. 

 

Figures 5.3(a) and (b) show the normalized mode area and propagation distance, 

respectively, as a function of d and for various values of h. For a large cylinder wire 

diameter d and spacer height h (d ˃ 1μm, h ≥ 0.25μm), the hybrid LRHPhP 

waveguide supports a low–loss cylinder-like mode in which the electromagnetic 
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energy is confined into the two high-permittivity cylinder wires [Fig. 5.4(a)]. 

Conversely, a small cylinder diameter (d < 1µm) leads to a single LRHPhP-like mode 

with very weak localization on both sides of h-BN/air interface and sustaining loss 

comparable to that of uncoupled LRHPhPs. At a specific value of d = 1μm, both the 

uncoupled mode indexes are equal to each other. As a result, the mode area is at its 

smallest as can been seen in Fig. 5.3(a). In addition, at d = 1μm, the mode character 

possesses equal contribution of both dielectric-cylinder mode and LRHPhP mode 

characteristics [Fig. 5.4(b)]. When h = 0.25μm and d = 1μm, the propagation distance 

is 2.46mm ≈ 370λ0 , while confining the energy within the spacers between the 

dielectric cylinders and h-BN slab to a modal area of approximately 10−1λo
2. If the 

spacer height h is reduced to nanometer scale, the electromagnetic field is strongly 

confined in the nanometer air gap between the cylinder and the h-BN interface [Figs. 

5.4(c) and 5.4(d)]. The minimum modal area can be achieved at cylinder diameter d 

= 1μm for different spacer heights h but at the cost of the shortest propagation 

distance [Figs. 5.3(a) and 5.3(b)]. For the case of d = 1μm and h = 0.01μm, the field 

has the highest confinement in the nanometer gap region with a modal area of 

approximately 10−2λ0
2 while still maintaining a relatively long propagation distance 

that is 7 times longer than the free-space wavelength. This explicitly shows the 

known trade-off between modal area and propagation distance. 
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Fig. 5.5. Normalized energy density along x = 0 [dashed line in inset in (a)] 

for h = 0.01μm (a), 0.05µm (b), 0.1μm (c), 0.25µm (d) shows the 

confinement in the air spacer. The shaded grey and blue areas represent the 

two dielectric wires and h-BN slab regions, respectively. The energy density 

along y = (t 2⁄ ) + h [dashed line inset in (e)] for h = 0.01μm (e), 0.05µm (f), 

0.1μm (g), 0.25μm (h). 
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Normalized energy densities along x= 0 and y = (t 2⁄ ) + h at d = 1μm for different 

spacer heights, h, are plotted in Fig. 5.5. This confirms that the stored 

electromagnetic energy is confined in the low-permittivity dielectric medium (here 

air) between the cylinder wire and the h-BN slab since the continuity of the 

displacement field at the material interfaces gives a strong normal electric-field 

component in the gap [1]. As h increases the electromagnetic energy in the gap region 

decreases, since the hybrid waveguide behaves as an effective optical capacitance. 

5.3 Coupling characteristics between long-range phonon polaritons and 

dielectric waveguide 

For the purpose of gaining a deeper understanding, we analyzed the dependence of 

the hybrid LRHPhP mode’s effective index, nhyb(d,h) on cylinder wire diameter and 

air spacer height. Figure 5.6 shows the variation in d of hybrid mode effective index 

for different air spacer heights h. In the limit of large d, the effective index 

approaches that of the pure dielectric cylinder wire mode, nwire(d), whereas for 

small d it converges to the pure LRHPhP mode, nLRHPhP, in agreement with the 

electromagnetic energy density analysis in section 5.2. At the same time, the hybrid 

LRHPhP mode’s effective index is always larger than the index of both the pure 

dielectric cylinder wire mode and the pure LRHPhP mode, indicating that the 

dielectric cylinder wire waveguide mode is coupling with LRHPhP mode. The 

mode’s effective index can be increased by increasing the diameter of the cylinder 
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wire, d, for a fixed spacer height, h, or by reducing the spacer height for a fixed d. 

This is because, as d increases or h reduces, the dielectric cylinder wire mode more 

effectively couples with the LRHPhP mode. 

 

Fig. 5.6. Effective index of the hybrid LRHPhP waveguide for a range of 

spacer height h versus cylinder wire diameters d, nhyb(colored lines). For 

comparison, the effective indices of pure cylinder wire, nwire (black solid 

line), and pure LRHPhP, nLRHPhP (black dashed line) are plotted.  

 

In order to explain the hybrid LRHPhP mode characteristics, coupled-mode 

theory is applied in which the hybrid mode is described as a superposition of the 

cylinder wire waveguide mode (without h-BN slab) and the LRHPhP mode (without 

cylinder wires) [1]. The hybrid mode can be expressed as  
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ψ±(d, h) = a±(d, h)ψwire(d) + b±(d, h)ψLRHPhP (5.3) 

where a±(d, h)  and b±(d, h) = √1 − |a+(d, h)|2  are mode amplitudes of the 

cylindrical wire modes ψwire(d) and LRHPhP mode ψLRHPhP. The square norm of 

the cylindrical wire mode amplitude, |𝑎+(𝑑, ℎ)|2 , is also known as the mode 

character and describes the degree to which the guided mode is cylinder-like or 

LRHPhP-like. It can be expressed in terms of the uncoupled mode indexes as follows, 

|a+(d, h)|2 =
nhyb(d, h) − nLRHPhP

(nhyb(d, h) − nwire(d)) + (nhyb(d, h) − nLRHPhP)
 (5.4) 

Figure 5.7(a) shows that when |a+(d, h)|2 > 0.5 , the mode is cylinder-like and 

LRHPhP-like otherwise. At the critical coupling diameter, dc , the cylinder mode 

amplitude |a+(d, h)|2 = 0.5, which means the cylinder and LRHPhP characteristics 

contribute equally towards the hybrid mode. In other words, the cylinder mode and 

LRHPhP mode propagate in phase and maximize the effective optical capacitance of 

the hybrid waveguide. As the cylinder wire diameter d increases, for each different 

value of h, the cylinder mode character increases which is consistent with Fig. 5.4(a), 

large h and d leads to a cylinder-like mode. At moderate values of h and d, the hybrid 

waveguide features both cylinder mode and LRHPhP-like mode [Fig. 5.4(b)]. 

According to the coupled-mode theory, for the hybrid LRHPhP waveguide, the 

coupling strength κ(d, h) between the dielectric cylinder mode and LRHPhP mode 

can be computed as [89]:  
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𝜅(d, h) = √(nhyb(d, h) − nLRHPhP)(nhyb(d, h) − nwire(d)) (5.5) 

Based on the tenets of coupled-mode theory, the hybrid mode is considered to be a 

superposition of the two uncoupled cylinder-wire and LRHPhP modes. The field 

enhancement in the spacer regions is a result of the field distribution overlay from 

these uncoupled modes that comprise the hybrid mode. As such, high energy 

confinement characterized by the reduction of the mode area and increase in field 

enhancement in the spacer regions corresponds to the maximum phase/index 

matching condition of the two uncoupled modes and thus the location of the 

maximum coupling strength as seen in Figs. 5.3(a), 5.6, and 5.7(b). Therefore, when 

the energy concentration or field enhancement in the gap between the cylinders and 

the h-BN slab is proportional to the coupling strength. 
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Fig. 5.7. (a) The cylinder mode character |𝑎+(𝑑, ℎ)|2 depends on wire 

diameter d from Eq. (5.3) for different spacer height h. (b) The dependence 
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of coupling strength κ on cylinder wire diameter d and spacer height h from 

Eq. (5.4). 

 

The dependence of coupling strength κ on cylinder wire diameter d and spacer 

height h are plotted in Fig. 5.7(b). It is shown that the coupling strength increases 

with decreasing spacer height h, which conveys the fact that the two modes couple 

more effectively as h reduces. Also the maximum coupling strength occurs at d ≈

1.25μm which is slightly shifted from d𝑐 ≈ 1μm. From Eq. (5.5), if nhyb(d, h) did 

not change with the cylinder diameter d for a fixed spacer height h, the dielectric 

cylinder mode and LRHPhP mode satisfy the phase-matched condition and 

nLRHPhP = nwire gives the maximum values of the coupling strength at d ≈ 1μm. 

In fact, both nhyb and nwire are changing with d which causes the shifting of the 

coupling strength. The coupling strength between the dielectric cylinder mode and 

the LRHPhP mode determines the optical energy concentration in the gap region. 

The field enhancement in the gap regions allows for efficient trapping of nanoscale 

particles. 

5.4 Conclusion 

We have proposed a hybrid long-range phononic waveguide consisting of two 

identical dielectric cylinder wires symmetrically placed on each side of a h-BN slab 

at mid-IR wavelength: 6.6μm. The hybrid short-range and long-range h-BN based 

hyperbolic phonon polariton modes are shown to exist, however the hybrid LRHPhP 
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mode provides propagation lengths that are significantly longer when compared with 

the hybrid SRHPhP mode while achieving comparable modal areas. The strong 

coupling between the LRHPhP mode and the dielectric cylinder wire waveguide 

mode results in a hybrid mode that can propagate distances up to 370λ0 and maintain 

sub-wavelength modal area within the spacers between the dielectric cylinder wires 

and h-BN slab of approximately 10-1λ0
2. The relationship between the parameters d 

and h for the physical geometry of the hybrid structure and the propagation length 

and mode area are characterized. A hybrid mode with a mode character at 50%, 

where the two uncoupled modes are index matched, results in a hybrid mode with 

the most confined hybrid mode, however, the hybrid mode suffers from a reduction 

in the propagation length. Hybrid modes with mode character equal to 50% are useful 

for applications where physical device footprint is the fundamental limiting 

requirement or when high field enhancement is needed for applications like sensing 

or particle trapping in nano-capacitive spacer region between the high index 

dielectric waveguide and h-BN. Given the numerous examples of molecular 

fingerprints in the mid- to long-wave IR spectrum, hybrid waveguide designs for 

enhancing and sensing such molecules have great potential for impact in lab-on-chip 

technologies. The region where the hybrid waveguide’s mode character is above 50% 

is used to achieve sub-diffractional long-haul energy transport for integrated 

polaritonic devices like interferometers in the mid-IR spectrum wherein mode area 
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is traded off for longer propagation length stemming from the high index waveguide 

attributes. 
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Chapter 6 

Conclusions 
 

In this dissertation, the different physical phenomena associated with surface 

electromagnetic modes coupled to dielectric waveguides in mid-IR have been 

studied. For such purpose, the finite element method has been used to develop 

accurate numerical models to calculate the electromagnetic fields bound to the 

waveguides. Due to the intrinsic Ohmic loss of noble metals, the advantage of surface 

plasmon polaritons are prohibitive at mid-infrared wavelengths. The goal of this 

research is using polar dielectrics in order to leverage the phonon polaritons in mid-

IR to overcome this loss.  

Chapter 3 of this dissertation concentrated on a new structure of a hybrid 

waveguide by using SiC as a polar material alternative to metal for mid-IR 

applications. This design achieves phonon coupling by placing a Si rectangular 

dielectric waveguide on a low dielectric permittivity material (BCB) with a SiC 

wafer substrate. This hybrid waveguide design realizes the subwavelength 

confinement in the BCB spacer. For free-space wavelength λ0 = 12.002μm, the best 

performance of field distribution and propagation distance up to 18.55λ0  can be 

achieved.  
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Chapter 4 has focused on the characteristics of phononic waveguide by using 

hyperbolic boron nitride. Uniaxial materials whose axial and tangential permittivities 

have opposite signs are referred to as indefinite or hyperbolic media. Artificially 

fabricated metamaterials could provide hyperbolic responses, however, they suffer 

from high plasmonic losses and require complex nanofabrication, which results size-

dependent limitations on optical confinement. Hexagonal boron nitride naturally 

possesses hyperbolic responses. This novel structure contains a dielectric Si wire 

above boron nitride slab, by changing the dielectric gap between the wire and slab, 

the mode coupling has been characterized. The strong coupling between the 

dielectric mode from the cylinder waveguide and phonon polaitons from h-BN slab 

enhances the confined field up to 10−3λ0
2 and enables propagation distance up to 

100λ0.  

Chapter 5 has the goal of further improving the propagation length while 

maintaining the same degree of mode confinement compared to previous design in 

Chapter 4. The numerical results for both long- and short-range phononic volumetric 

polariton modes in a slab of h-BN has been shown in this chapter. A hybrid LRHPhP 

waveguide consisting of two identical dielectric cylindrical wires placed 

symmetrically about a h-BN slab embedded in a low-permittivity dielectric medium 

in the Type II restrahlen band is proposed. Compared with our previous work, this 

new design is capable of achieving more than two orders of magnitude larger 

propagation length while maintaining the same degree of mode confinement. 
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LRHPhP waveguides constitute a new class of components that can provide guiding 

of light as well as coupling and splitting from/into a number of channels with 

reasonable insertion loss and good waveguide performance. All described features 

of the hybrid LRHPhP technology may eventually lead to numerous applications of 

hybrid LRHPhPs in different fields ranging from integrated circuits to 

subwavelength laser and biological sensing.  

Fabrication and optimization of hybrid waveguide components, ranging from 

straight waveguides to couplers, as well as coupling the light source to hybrid 

phononic waveguide is an ambitious task, and hopefully, this dissertation can be used 

as basis for the future hybrid phononic related research. 
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Appendix 

Hybrid LRHPHP h-BN waveguide model setting 

in HFSS 

1. Set solution type: 

HFSS → Solution Type → Eigenmode→ OK 

 

2. Set model unit: 

Modeler → Unites → Select um → OK 
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3. Set h-BN material: 

Open material tool bar → Select →Add material  

 

 

Material set up for h-BN in Type II reststrahlen band at 45.45 THz 
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Same process to set up two GaAs cylinder dielectric waveguides material 

 

4. Define variables 

HFSS → Design Properties → Add d = 1um, h = 10nm, t = 0.5um, L = 10nm, XL = 

40um, YL = 16um, T1 = 16um, BL = 0.0124715rad, Per = 1.71653388 as local 

variables; d, h, t, L, XL, YL, T1, BL and Per represent the cylinder diameter, air gap 

height, h-BN slab thickness, master and slave boundary separation, air-box width, 

upper air-box height, lower air-box height, Phase delay between master and slave 

boundary and relative permittivity.  
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5. Draw a box 

Draw → Box 

 

6. Specify the dimensions and position with variables for upper air box 
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7. Change the attributes 

Double click on Box1 for the attribute menu, change the name to Air1, the material 

to air, color to purple, and set the transparency to 0.94.  

 

8. Fit the view in the 3D modeler window  

CTRL + D, Shift + Mouse left and Alt + Mouse left 

9. Draw h-BN slab and change the attributes 

Draw → Box  
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Double click on Box1 for the attribute menu, change the name to h_BN, the material 

to h_BN_45.45THz, color to light blue, and set the transparency to 0.6.  

 

10. Draw the bottom air-box and specify the dimensions and position with variables 
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11. Change the attributes 

Double click on Box1 for the attribute menu, change the name to Air2, the material 

to air, color to purple, and set the transparency to 0.94.  

 

12. Draw the upper cylinder 

Draw → Cylinder 

Enter the position and the dimensions of the created cylinder as shown in the figure 

below. 
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13. Change the attributes  

Double click on Cylinder 1 for its attribute menu and change the name to GaAs1 

and material to GaAs 

 

14. Subtract the GaAs1 from Air1 

Mouse left click Air1 → CTRL + mouse left click GaAs1 → Modeler → Boolean → 

Subtract 
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15. Draw the bottom cylinder 

Draw → Cylinder 

Enter the position and the dimensions of the created cylinder as shown in the figure 

below. 

 

16. Change the attributes  

Double click on Cylinder 1 for its attribute menu and change the name to GaAs2 

and material to GaAs 
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17. Subtract the GaAs2 from Air2 

Mouse left click Air2 → CTRL + mouse left click GaAs2 → Modeler → Boolean → 

Subtract 

 

3D-view of the h-BN hybrid LRHPHP waveguide 
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18. Set up master and slave boundary  

Draw → Rectangle  

Enter the position and the dimensions of the created rectangle as shown in the figure 

below. 

 

19. Change the attributes  

Double click on Rectangle1 for its attribute menu and change the name to Master 

and set the transparency to 1. 
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20. Set up the master boundary condition 

Mouse right click Master→ Assign Boundary → Mater → New Vector 

 

21. Set up master boundary vector position 

Put the mouse at the left bottom corner of the bottom air-box and click  
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Move the mouse to the right corner of the bottom air-box and click 

 

Click the Reverse Direction → OK 
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22. Set up the slave boundary 

Draw → Rectangle  

Enter the position and the dimensions of the created rectangle as shown in the figure 

below. 

 

23. Change the attributes  

Double click on Rectangle2 for its attribute menu and change the name to Slave and 

set the transparency to 1. 
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24. Set up the slave boundary condition 

Mouse right click Slave → Assign Boundary → Slave 

 

25. Set up the slave boundary vector direction 

The master and slave boundary vector direction must be in same direction but 

opposite face as shown in the figure below 
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26. Set up phase delay between master and slave boundary condition 

 

27. Create an Analysis 

HFSS → Analysis Setup → Add Solution Setup → General tab 

Solution Frequency: 45.4 THz 

Number of Modes: 3 

Maximum Number of Passes: 20 

Maximum Delta S: 0.01 
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28. Validation Check and Analyze All 

HFSS → Validation Check  

Click Close if all pass 

HFSS → Analyze All  

Use Message Manager to view any warning or error message 

30. Check the simulation result  

Mouse left click Solution Data 
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31. Check the field distribution 

Edit → Select → Faces; Edit → Select → By Name → Master → Face278 → OK 

 

Mouse right click Field Overlays → Plot Fields → E → ComplexMag_E 
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Same process for plotting H Field  

 

32. Calculate the normalized modal area 

HFSS → Fields → Calculator 
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121 

 

 

33. Calculate the propagation distance 

The eigenmode solver of HFSS gives us the eigenvalue which is the frequency. The 

master and slave boundary conditions give the infinite length of the waveguide in the 

z direction, in our case z is the propagation direction. When we set up the master and 

slave boundary condition, there is a parameter named phase delay (BL) that needs to 

be determined. The effective index is related to the phase delay. First, we define the 

phase delay in this form, 

β = BL d⁄           (A-1) 
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where β is propagation constant in the unit of rad/m, BL is the phase delay of the 

master and slave boundary in the unit of rad, d is the separation distance between 

master and slave boundary in the unit of nanometer (here is 10nm).  

The effective index is related to β.  

neff = β ∙ 𝜆0 2π⁄           (A-2) 

 

The propagation distance is related to the Q factor which comes from the eigenmode 

solver in HFSS. Q is the quality factor of the waveguide. The propagation length (PL) 

is in a form, 

PL = 1 (2α)⁄           (A-3) 

 

where α is the attenuation constant and, 

α = β 2Q⁄           (A-4) 

 

34. Plot the normalized electromagnetic energy density 

Draw → Line (arbitrary position) → Mouse double left click CreateLine → Type the 

points positions as shown in the figure below 
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Mouse right click Results → Create Fields Report → Rectangular Plot 
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